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Reports 
 Click icon to view the Standard Report Listing in Adobe Portable Document Image (PDF) format. 

 Click icon to open this entire document in Adobe Portable Document Image (PDF) format. 
 
 
MoversSuite has taken great effort to work with its customers to develop documents that are useful to 
all users.   Customizable invoices, dispatch work tickets, sales summaries, and many, many more reports 
and other documents that range from the simple, such as printable hauling labels, to the complex, such 
as accounting reporting tools, are available. 
 
In addition to these easily accessible documents provided by MoversSuite, MoversSuite can 
accommodate a client’s own list of custom documents, providing a complete reporting environment. 
 
 

Reporting with MoversSuite 
 
Documents, forms, letters, reports, invoices, and other similar forms of output are referred to as 
Reports within MoversSuite.  This is due to MoversSuite’s seamless integration with the robust 
Microsoft SQL Server Reporting Services reporting tools.   
 
Although Reporting Services is the primary document rendering tool, the application is versatile enough 
to work with many other tools, including Crystal Reports and Microsoft Word documents. 
 
The use of bookmarked fields, that map MoversSuite data to a Microsoft Word document, will continue 
to be a developed resource, adding to the ever increasing list of reporting options. 
 
Set up and maintenance of these files is accomplished through the Reports setup within the Mover’s 
Suite Administration.  Additionally, access to the documents is controlled through assigning personnel a 
Report Profile through this tool, as well. 
 
Once a user has been assigned a profile, they will be able to access the documents established for their 
Report Profile in a variety of ways:  From the application’s menu bar, from buttons placed throughout 
the application, and through Reporting Services, directly. 
 

 
Figure 1: Reports menu options 

 

standard_report_listing.pdf
user_guide_to_reports.pdf
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The reports listed in the Reports drop-down menu are all those assigned to the particular person logged 
into MoversSuite (as assigned through their Report Profile). 

 
 

 
Figure 2: Reports menu 
 

Selecting a report from the menu will invoke the Report Viewer window to display the contents of the 
report. 

 

 
Figure 3: Task List report 

 
 

Standard Reports Provided by MoversSuite 
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An extensive list of quality documents is provided as a standard part of the MoversSuite Software 
package.  Most of these documents are designed, generated, and viewed through Microsoft SQL Server 
Reporting Services, except where indicated, and are categorized into the following areas: 

 Accounting and Financial Services Documents 

 Common Services Documents 

 Move Management Services Documents 

 Move Management Services Forms 

 Reporting Tools 

 
Items not included in this description are those that have been modified for, or by, a customer.  Contact 
your system administrator, or your MoversSuite Professional Services contact, for more information on 
custom or modified reports.  Refer to the Standard Report and Document Listing section for more 
information. 
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Using Report Documents 
 
Once the documents and profiles have been established, a user can launch and view the reports 
assigned to them in one of the following ways: 

 Reports menu option, available from the application’s main toolbar, 

 Letters menu option, available from the application’s main toolbar by Reports > Letters, 

 Buttons available throughout the MoversSuite application, 

 Accessing the report service directly through the Report Manager (Microsoft SQL Server 
Reporting Services). 

 

Report Menu Option 
 
Reports defined in Reports Setup will be available through the Reports menu option.  This is available 
through the application’s main toolbar by selecting Reports. 
 

 
Figure 4: Accessing Reports from the main toolbar 

 
Pressing the Reports button will open up a report listing, which includes two sections: An upper section 
that produces system-generated documents that require specific data that the application passes to the 
document generator; and a lower section that contains all general purpose reports, documents, and 
forms. 
 
The upper section includes a link to a separate listing of documents defined with a Report Type of 
“Letters.” 
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Figure 5: Reports menu 

 
System-generated documents (all those in the upper section, including Letters) may require that a 
record be opened within MoversSuite otherwise the report generator may return an error.   
 
Selecting a document defined with a Report Type of “Letters” will cause the program to open a 
Microsoft Word window to display the generated content. 
 
Otherwise, the application will open a Report Viewer, displaying the contents of any Reporting Services 
and Crystal Reports documents.  Often the report will generate the output automatically, but the user 
has the option to reset the parameters and can re-run the report using the View Report button. 
 

Report Viewer 
 
The most prevalent report-generation tool is the Report Viewer.  This application is included with the 
Microsoft SQL Server Reporting Services suite and is used by MoversSuite to process Reporting Services 
Reports and Crystal Reports documents.  Note: Some Crystal Reports documents will not work with 
Reporting Services and may need to be generated through a Crystal Reports server. 
 
The functional components of the Report Viewer are listed below. 
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Figure 6: Report heading section 

 

Report Viewer Options 
 

 
Figure 7: Report Viewer options 

 
Report Viewer options are detailed in the following table. 
 

Image Ref. Description 

1 Show or Hide Document Map 

The document map allows a user to jump to other referenced locations within the report 
such as breaks and individual records. 

2 Show or  Hide Parameter Area  

This option allows the user to show or hide the parameter entry area. 

3 Page Navigation 

User can choose to navigate to the first, previous, next, or last page or choose to enter a page 
number to jump to in the report. 

4 Back to Parent Report 

This option will take the user to the parent report if the reports are built in a hierarchy and 
linked together.  Note: This option is disabled for most Mover’s s Suite reports. 
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5 Cancel Report 

If the report is being rendered, then the user can choose to cancel the report generation 
process. 

6 Refresh Report 

This is the same as the View Report option which regenerates the report. 

7 Print Report 

Opens a Print dialog where a user can send the contents of the report to a printer. 

8 Printer Layout 

This option will display the report as it will be rendered by the printer. 

9 Page Setup 

Opens the Page Setup dialog where a user can change the report size, orientation, margins, 
and other print and page functions. 

10 Save Report 

A user can select from several options to save the output of the report in a physical form. 

 

11 Zoom Display 

A user can change the size of the report by choosing from a list of zoom options. 

 

12 Report Search 

A user can enter a description in the blank text box and press Find to search the contents of 
the opened reports.  Search hits will be highlighted and the user can toggle back and forth 
between the matches using the Find and Next buttons. 
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A user can quickly become accustomed to using the various report options and a user will know when 
the Report Viewer is generated by a “Report is being generated” indicated (Figure 8). 
 

 
Figure 8: Report generation symbol 

 
 
If this indicator is not present, then a user should attempt to regenerate the report by pressing the View 
Report button.  A user will always need to press this button after report parameters have changed. 
 
The output of each report will either be in landscape or portrait layout, depending on the need of the 
report.  While the Report Viewer window can be adjusted, the layout cannot be altered without special 
report customization. 
 

Letters Menu Option 
 
All documents defined with a Report Type of “Letters” and are not assigned to a button (through the 
System ID setting) will appear within the Letters sub-menu. 
 

 
Figure 9: Letter document listing 

 
All Letters documents will be generated and viewed through a Microsoft Word document viewer.  
Bookmark files are the most common type of Letter document and they provides an easy way for a user 
to define and produce custom forms, letters, etc.  Refer to the Bookmarks subject for more information.  
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Accessing Documents through Buttons 
 
In addition to the Reports > Letters menu options available from the application’s menu bar, a user can 
also access documents by various buttons found throughout the application.   
 
The System ID setting within the Reports setup controls which documents are referenced through a 
specific button.  For example, the document that references the Report table System ID setting of OLAB 
will appear when the Print Label button is pushed from within the Name, Address, Phone tab. 
 

 
Figure 10: Print Label button available through the Name, Address, Phone tab 

 
Refer to the System ID Setting section for a complete listing of available buttons and understanding of 
its setup. 
 

Accessing Reports through a Reporting Server 
 
Reports can also be viewed directly through the Microsoft SQL Server Reporting Services, by means of 
the Report Manager application.  This application is accessible through a web browser, such as 
Microsoft Internet Explorer 7.  Contact an Information Technology (IT) expert for more information for 
the specifics of accessing the Report Manager. 
 
When the Report Manager is successfully loaded into a web browser window, a user may have access to 
running and viewing all reports loaded into the service.  The security that controls file access in 
MoversSuite is not present here. 
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Figure 11: Report Manager as viewed within a web browser 

 
Selecting a folder will list its contents within the same window.   
 
When all the standard Reporting Services reports from MoversSuite are loaded into a single-folder, then  
a user would see the following folder structure. 
 

 
Figure 12: List of standard MoversSuite report directories 

 
Selecting one of the listed categories will display its contents to the same screen.  Eventually, a user will 
be able to see the list of available reports, along with a description of what they report. 
 

 
Figure 13: Reports and their descriptions 

 
 



User Guide to Reports 

Mover’s Suite Software, LLC 14 

 

Note: All reports available within the Report Manager are also available to the MoversSuite application.  
Reports listed within the Report Manager can be linked to MoversSuite through the Reports setup by a 
Render Type setting of Reporting Services Report.   
 
Selecting one of the reports within the Report Manager will cause the Report Viewer to be launched.  
The output will be generated and displayed in the same window as that of the listing.   
 

 
Figure 14: Report accessed directly through the Reporting Services Report Viewer 

 

Tip: Use the Report Manager’s search utility to locate existing files by their Name, including report 
and image files.  The search utility is located in the upper right-hand corner of the Report Manager 
window. 

 

Figure 15: Report Manager search feature 

 

Uploading to the Reporting Services Server 
 
The Report Manager can be used to add custom Reporting Services reports or to update existing ones.  
The process below describes how the Report Manager can used to upload a report file in a report server. 
 

Important: The files must be defined as a Report Definition Language (RDL), aka Report Definition File, 
file in order to be uploaded into Reporting Services.  Special procedure files and related database 
changes that may need to accompany the file must also be in place prior to executing the report. 

 

Uploading Reporting Service Reports using Report Manager 
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1. Open a web browser, such as Microsoft Internet Explorer, from a computer that has sufficient 
privileges to access the company’s report server, 

2. Enter the URL that opens the Microsoft SQL Server Reporting Services Report Manager 
application hosted on the company’s report server.  Typically, the URL format is http://report 
server/Reports$instance/, where the red italicized settings are specific to a user’s system, 

 

Figure 16: Sample URL to access Report Manager 

The SQL Server Reporting Services screen will appear, 

 

Figure 17: Report Manager screen 

3. Open and access the folder in which the uploaded report will reside.  Note: The New Folder 
option can be used to create a separate locale for reports, 

4. Click on Upload File ( ) and the Upload File screen will appear, 

 

Figure 18: Upload File screen 

5. Press Browse to locate the RDL file using the Choose File utility, 
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Figure 19: Choose File window 

6. Select the correct report and press Open and the file name will be painted in the File to upload 
field, 

 

Figure 20: Report Manager Upload File screen 

7. Select the Overwrite item if it exists.  This option instructs the application to replace an existing 
version of the report existing in the report server, 

Important: If this option is not selected and the report already exists on the server then the 
new file will not be uploaded. 

8. Press OK and the report will be inserted into the open folder.  Reports inserted into the report 
server since the last server update will be flagged with a flag, 
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Figure 21: New report sample 

Verify the report properties: 

9. Click on Show Details and the screen will display the Edit options, 

 

Figure 22: Show Details  

 
Tip: Using the Show Details option will enable the Delete and Move options. 
 

10. Press Edit ( ) to access the report Properties, 

Make adjustments within the General, Parameters, Data Sources settings as needed.  
Important: Press Apply on each screen to ensure that the changes are committed.    

Often a new report will need to have the data source updated in order to view the report.  A 
report with an invalid data source will return the following error when viewed: “The report 
server cannot process the report.  The data source connection information has been deleted.  
(rsInvalidDataSourceReference)” 

Update a data source: 

a. Open the Properties tab, 

b. Select Data Sources option, 
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Figure 23: Data Sources > A shared data source setting 

c. Check the A shared data source option, 

d. Press Browse and the screen will list the directory of the report server, 

 

Figure 24: Data source selection 

e. Select the appropriate data source (denoted by  ), 

f. Press OK and the selected data source will appear as the shared data source, 
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Figure 25: Specified data source  

g. Press Apply (bottom of screen) to commit the changes.  The report will now reference 
this data source when executed. 

11. Click on the View tab to execute the report and view its output. 
 

 

Figure 26: View tab 

Reports loaded into the report server will be accessible to MoversSuite.  Refer to the Report Setup and 
Administration section to understand how to link a Reporting Services report to a MoversSuite menu 
item. 
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Report Setup and Administration 
 
Report documents are any files that can be generated from within the MoversSuite application.  They 
include reports, forms, invoices, letters, quotes, etc.   The output of these documents can be rendered 
through one of the three, supported document generation applications: 

 Crystal Reports  

 Microsoft Word 

 Microsoft SQL Server Reporting Services  

 
A moving company can define their own set of document to work with these applications or use those 
provided by MoversSuite.  To view the list of standard MoversSuite reports access the Standard Report 
and Document Listing section. 
 
This topic informs an user on how to set up documents to work within MoversSuite and how a user can 
be set up to generate these documents. 
 

Reports Setup 
 
The way in which MoversSuite identifies documents available to be rendered, and how they are to be 
generated, is accomplished through the Reports setup within the Mover’s Suite Administration.  Use 
this tool to identify, update, and add to the list of reports that can be generated through MoversSuite. 
 
Administrative setup of Reports involves the following areas: 

 Report Type Settings 

 Report Name Settings 

 Report Path Settings 

 System ID Settings 

 Render Type Settings 

 
The following procedure can be used to generically identify which documents are available to users 
through the MoversSuite application.  One can follow this procedure to add documents, modify existing 
ones, or isolate problems. 
 

Adding a Reports document 

1. Access the Mover’s Suite Administration, 

2. Open the Common > Reports > Reports setup, 
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Figure 27: Reports setup section 

 

3. Click the mouse in the row describing “Click here to add a new row”, 

4. Enter a Menu Name.  This is the name that appears for the document within the Reports menu 
of MoversSuite application, 

5. Enter a Report Name.  This is name of the physical file as it exists within the application server 
or the name recognized by Reporting Services.  See the Report Name Setting section for details, 

6. Enter Report Path.  This is the path (directory) that is a prefix of the Report Name.  See the 
Report Path Setting section for details, 

7. Select a Report Type.  This setting determines which application is to be used to process the 
document.  See Report Type Setting section for details, 

8. Optionally enter a System ID to have the document available through a button.  See the System 
ID Setting section for details, 

9. Optionally select a Render Type.  This value instructs the program as to which file extension to 
use when saving the output of the document, when generated through a batch process.  See the 
Report Type Setting section for details, 

10. Press the Tab key to add the record to the database, 

11. Repeat Steps 3 through 10 to define other documents. 

 

Once successfully defined, the Reports documents can be associated to a report profile (a grouping of 
reports that can be assigned to personnel) as described within the Allowing Access to Reports 
Documents section. 
 
Refer to the Custom Report Document Setup section for specifics on custom reports settings. 
 
The Sample Reports Settings section contains several examples of the Reports setup. 
 
 

Quick Reference to Reports Settings 
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A quick reference to the Reports settings is listed in the table below.   
 
Refer to this section when making changes to the Reports table from within the Mover’s Suite 
Administration.   
 

Field Name Description 

Menu Name 

(required) 

The name that appears for the document within the MoversSuite application.   

Example: “Confirmation Letter” 

Report Name 

(required) 

The name of the physical file as it exists on one’s system, or the name recognized by 
Reporting Services document.  This option is dependent on what is set for the Report Type. 

For documents that have a Report Type of Letters, then this must be a Microsoft Word 
document with the filename extension of either doc or docx (Microsoft Word 2007). 

Example:  “Confirmation.docx” 

For documents defined with a Report Type of Crystal Reports, the file referenced must have 
been created using the Crystal Reports application and have a file extension of rpt. 

Example:  “Printer_Alignment_Form.rpt” 

Reporting Services Reports documents must be referenced by their file name and the 
directory structure as they exist on the server. 

Example: “/[Account]/Move Management Services/Task List” 

This is where [Account] represents the top-level directory within the Reporting Services 
Report Manager and may indicate a specific release of MoversSuite. 

For custom Reporting Services Reports, a user may want to create a Custom folder at the 
highest level within the Report Manager.  See the Custom Report Document Setup section 
for more information on custom reports. 

Report Path 

(required) 

This is the path (directory) that is a prefix to the Report Name.  As with the Report Name, 
this option is dependent upon the Report Type setting.  

For documents that have a Report Type of Letters and Crystal Reports, this will be the 
location within the server that contains the files.   

Example:  “\\[Server Name]\mssShare\mssLetters\Crystal Reports\” 

This is where [Server Name] represents the name of the server that hosts MoversSuite. 

For Reporting Services Reports documents, this would be the URL that references the 
report server and the Reporting Services web service. 

Example: “http://*Server Name+/ReportServer” 

This is where [Server Name] represents the name of the report server. 

See the Custom Report Document Setup section for more information on custom reports. 

Report Type 

(required) 

The Report Type instructs the program on how the file should be generated. 

Options: 

Crystal Report, 

Letter, 

Reporting Services Report. 
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System ID 

(optional) 

In general, the System ID is a four-character identifier that allows the document to be 
launched from a button within the MoversSuite application. 

For example, assigning a System ID of “CLAM” will allow for the document to be made 
available through the Report/Letters button from within the Claims interface. 

 

See the Accessing Documents through Buttons section for further details on each of these 
codes. 

Render Type 

(optional) 

This setting determines how the file should be saved, when generated through a batch 
process. 

Options: 

PDF  (adds “.pdf” to filename) 

EXCEL  (adds “.xls” to filename) 

 
 

Report Type Setting 
 
The Report Type option defines which method MoversSuite will use in generating output from the 
document.  There are currently three options available: 
 

Valid Report Type Description 

Crystal Report The file will be generated using Crystal Reports. 

Letter The file will be generated using Microsoft Word. 

Reporting Services Report The file will be generated using Microsoft SQL Server Reporting Services. 

 
This option affects what is entered for the Report Name and Report Path options. 
 

Report Name Setting 
 
The Report Name is the name of the physical file as it exists on one’s system.  It can also be the name of 
the document uploaded into a Reporting Services server.   
 
This option is dependent on what is set for the Report Type.   
 
The table below attempts to illustrate the appropriate Report Name values that should be set depending 
on what the Report Type is set to. 
 

Report Type is Set to: What is expected for Report Name values: 

Crystal Report The file will be generated through Crystal Reports and must have a file 
extension of rpt. 
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Example:  Printer_Alignment_Form.rpt 

Letter The file will be generated through Microsoft Word and should have a file 
extension of either doc or docx (Microsoft Word 2007). 

Example: Confirmation.docx 

Reporting Services Report The file will be generated through Microsoft SQL Server Reporting 
Services.  No file extension is needed, but the name specified must match 
that of what has been loaded, or saved, within Reporting Services. 

Example: /[Account]/Move Management Services/Task List 

This is where [Account] represents the top-level directory within the 
Reporting Services Report Manager and may indicate a specific release of 
MoversSuite. 

 
For custom Reporting Services Reports, a user may want to create a Custom folder at the highest level 
within the Report Manager.  See the Custom Report Document Setup section for more information on 
custom reports. 

Report Path Setting 
 
This is the path, or directory location, that is a prefix to the Report Name.   
 
This option is dependent on what is set for the Report Type.   
 
The table below attempts to illustrate the appropriate Report Path values that should be set depending 
on what the Report Type is set to. 
 

Report Type is Set to: What is expected for Report Name values: 

Crystal Report or Letter For these documents, the Report Path will need to reference the physical 
location of the file within the application server. 

Examples: 

\\[Server Name]\mssShare\mssLetters\Crystal Reports\ 

\\[Server Name]\mssShare\mssLetters\Custom\ 

This is where [Server Name] represents the name of the server that hosts 
MoversSuite. 

See the Custom Report Document Setup section for more information on 
modifying this setting for custom reports. 

Reporting Services Report For Reporting Services Reports, this must be the URL that points to the report 
server that hosts the Reporting Services. 

Example: http://[Server Name]/ReportServer 

This is where [Server Name] represents the name of the report server. 

 
The Report Path is used in conjunction with the Report Name to produce a complete mapping to the 
location of the source of the document.  If, for example, the document is a Reporting Services Report 
document, then a possible complete reference would be as follows: 
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http://Server/ReportServer/MoversSuite/Move Management/Task List 

 
 

System ID Setting 
 
The System ID is a four-character identifier that, when set for a document in the Reports setup, will 
allow the document to be available through a button within MoversSuite.  An example of this is the 
Print Label button available through the Name, Address, Phone tab. 
 

 
Figure 28: Print Label button on the Name, Address, Phone tab 

 
 
When the application renders a document through a button, it passes record-specific data to a third-
party application such as Microsoft Reporting Services or Microsoft Word (Letters) and displays the 
content of the filled-in document in a separate window.   
 
In addition to allowing a document to be rendered through a button, the System ID values also instruct 
the application to send data regarding a specific record to the output generation application (e.g. 
Microsoft SQL Reporting Services).  The document being rendered must be able to accept this data.  If it 
cannot, then the user will receive an error. 
 
Administrators must be aware of what is required by the document from the requesting application in 
order for the process to work correctly.  For example, the use of the HLAB value (for the Print Label 
button) will require that the Order ID be present (a valid Order Number) and the standard label 
document will call on Reporting Services to generate the output.  By assigning the HLAB value to a 
document, MoversSuite will attempt to pass the Order ID to the Reporting Services.   If the document 
does not accept the Order ID as an argument, then the user will receive a Reporting Services error.   
Likewise, if a document is assigned the HLAB value then it must be setup to take in the Order ID. 
 

Available System ID Values 

 
Use the following table to identify what System ID values can be referenced, including which button(s) it 
represents along with the standard document supplied by MoversSuite. 
 
Notes: 

 A System ID value can only be referenced once in the Reports table settings, except for CLAM, 
INTL, MILT, and QUOT which can be referenced by more than one report document (indicated a 
red in the table below).  Refer to the Multiple Document Settings section. 
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 The System ID setting instructs the application to pass information about the record being 
accessed to a particular document.  If the information being passed to the document is not 
correct, the user will receive an error.  In general, reports that reference more than one record 
will cause an error if rendered through a button. 

 

System 
ID Button(s) Text Location within Application 

Standard Default Report 
Name 

CASH Print Receipt Cash Receipts > Cash Receipts Payment Receipt 

CLAM Reports/Letters Claims Not available. 

CSMR Create New 
Statement 

Accounting Tools > Commission Statement 
Management 

Commission Statement 

GLES VL Distributions Accounting Tools > Payment Management Payment Management 
Vanline Distributions 

HLAB Hauling Label Reports > Hauling Label Hauling Label 

INTL Forms Shipping Information Not available. 

MILT Military Form Military/Government Gov DD1840 

Gov DD1840 Delivery Out 

Gov DD619 

Gov DD619-1 

OLAB Print Label Name, Address, Phone Standard Label 

PBER Generate 
Transactions 

Accounting Tools > Payment Management 
> Detail Processing 

Payment Management 
Transaction Errors 

PDEP Deposit Report Accounting Tools > Payment Management 
> Batch Management 

Deposit Statement 

QUOT Generate Quote Quote Quote 

REVI New Complete 

New Supplemental 

Revenue Entry > Summary Tab > Invoice 

Claims > Summary Tab > Invoice 

Standard Invoice (long) 

RSBI View Invoices  Accounting Tools > Recurring Billing 
Management  

Standard Invoice (short) 

SSTR Supplemental Invoice Reports > Supplemental Invoice Special Services Invoice by 
Store 

STRK Invoice Reports > Invoice Special Services Invoice by 
Order 

 Note on SSTR and STRK: If the task group associated to the order has the Invoice By counter set to a 
non-zero value then the STRK document will be rendered for the Reports > Invoice option, otherwise 
if the Invoice By counter is zero then the report referencing SSTR will be rendered.  Refer to the 
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System ID Setting for Special Services Invoices for more information. 

STMT Generate Accounting Tools > Customer Statement 
Generation  

Customer Statement 

WORK Work Ticket Local Dispatch > Dispatch Center Work Ticket 

 
 

Multiple Document Settings 

 
Several System ID values can be referenced by multiple documents within the Reports table setup, they 
include the following:  

CLAM 

INTL 

MILT 

QUOT 

REVI 

RSBI 

 
Each of these System IDs represents a button with a drop-down menu option.  This feature allows a user 
access to an unlimited number of documents.  The System ID of CLAM, for example, will allow the report 
to be accessed through the Reports/Letters menu within the Claims interface. 
 

 
Figure 29: Reports/Letters within Claims 

 
 

Render Type Setting 
 
A user can define how output of the generated document is to be saved by setting the Render Type 
within the Reports setup of the Mover’s Suite Administration.  This setting only applies to documents 
generated in batch or as part of an internal function, such as archiving invoices and quotes. 
 
For example, when the monthly recurring billing and storage process produces invoices, it can be 
instructed to save the output as an Adobe Portable Document Form (PDF).  In such a case, it would be 
tedious to require a user to manually set the output type. 
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These same options are available to Reporting Services Report files that are interactively generated by a 
user from within either the MoversSuite application or through the Report Manager.  Refer to Accessing 
Reports through a Reporting Server section for more information. 
 
Listed below are the available Render Types and the extension used to save the file with. 
 
Render Type Descriptions 
 

Code Description File Extension 

PDF Adobe Portable Document Format file .pdf 

Excel Microsoft Excel Format file .xls 

 

 

Adding Branch and Van Line Images to Documents 
 
A company can display their logo or its van line image on report documents such as invoices and 
customer statements.  The following standard report documents provided by MoversSuite have the 
ability to display images for the branch and van line: 

Customer Statement 

Quote 

Standard Invoice (long) 

Standard Invoice (short) 

 

Important: Only certain report documents have been designed to display the branch or van line image, 
such as those listed above.  Contact MoversSuite to find out more about adding images to other 
documents. 

 
For all documents, the branch image will generally appear on the left while that of the van line will 
appear on the right. 
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Figure 30: Branch and van line image locations on an invoice document 

 
 
The following steps are needed to add a branch or van line image to a report document: 

1. Upload the image file into the Microsoft SQL Server Reporting Services  

2. Set the Image URL field for the Branch and Van Line records to recognize the image file 

3. Set the Invoice Properties settings to turn on the imaging functionality for report documents 

 
The image files supported by this functionality include all those widely accepted by most web browsers, 
such as Microsoft Internet Explorer and Mozilla.  These file types include BMP,  GIF, JPEG, PNG, TIFF  and 
may need to be adjusted to fit correctly within the two by three inch area available on invoices, quotes, 
and customer statements. 
 
 

Uploading the image file into Microsoft SQL Server Reporting Services 
 
MoversSuite will use the Report Viewer to produce the output of documents including the images 
therefore the image files need to be loaded in into Microsoft SQL Server Reporting Services through the 
Report Manager and specifically into the application folder titled “System”. 
 
The Report Manager is part of the Reporting Services product base and allows an administrator to 
interact with the report server and perform tasks such as uploading report and image files, set the 
database pointer, and execute and view reports. 
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Figure 31: Upload File option in Report Manager 

 
Use the Report Manager to update company and van line images into the System folder. 
 

Uploading an image file using Report Manager 

12. Open the Microsoft SQL Server Reporting Services Report Manager application using a URL that 
points to the service executing on a report server through a web browser.  An example of the 
URL format is http://report server/report instance/, 

13. Access the folder that contains the report documents used by the MoversSuite application, 

14. Click on System to open the folder (typically Home > MoversSuite > System).  The image file will 
need to be uploaded to the same folder as the documents that will be referencing it.  For 
example, the standard Customer Statement document exists in the System folder therefore the 
image file must be in this same folder.  Note: If the image file is uploaded into a different folder 
than that of the report document, then the application will be unable to render the image, 

15. Click on Upload File, 
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Figure 32: Upload File page in Report Manager 

16. Click on the Browse… button to use the Choose File dialog to locate the image file to upload, 

17. Once the File name is set within the Choose File dialog press the Open button.  Note: The File to 
upload field will be updated along with the Name field once a file is selected, 

18. Choose to Overwrite item if it exists to purge an existing document with the same name.  
Important: If the Overwrite item if it exists option is not on (checked) and a document with the 
same name is found in the report server, then new file will not be uploaded, 

 

Figure 33: Sample file and name for an upload file 

 

Tip: Use the Report Manager’s search utility to locate existing files by their Name, including 
report and image files.  The search utility is located in the upper right-hand corner of the 
Report Manager window. 
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Figure 34: Report Manager search feature 

  

19. Press the OK button from the Upload File page to perform the upload, 

20. Repeat Steps 4 through 8 to upload other files into the report server. 

 
The image file will be visible within the System folder and will be available to be referenced by 
documents rendered through Microsoft SQL Server Reporting Services. 
 
Successfully uploaded images will be listed along with all existing files stored within the report server.   
 

 
Figure 35: Uploaded image file 

 
Tip: Clicking the file name will display the contents of the image file to the screen. 

 

Making a image available to branch and van lines documents 

The second step needed to add images to branch and van line documents is update the Image URL field 
for each branch and van line record. 
 

Update the Image URL field to reference an uploaded image file 

Set the branch image reference: 

1. Open the MoversSuite Administration - web, 
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2. Click on Common > Branch Setup, 

3. Select a Branch from the available list, 

4. Press Edit to update the branch data, 

5. Enter the Image URL as the name of the image document uploaded into Microsoft SQL Server 
Reporting Services.  The name that the file assigned to the image when it was uploaded is what 
will need to be entered here, character for character.   Case lettering of the Image URL is 
ignored, therefore “logo.jpg” is treated the same as “LOGO.jpg”,  

 

Figure 36: Image URL field within Branch Setup 

6. Press Save to keep any changes made, 

7. Repeat Steps 3 through 6 to assign an image file to other branches, 

Set the van line image reference: 

8. Open the Mover’s Suite Administration, 

9. Locate and open the MMS > General > Van Line setup folder, 

10. Select a van line by Van Line ID, 

11. Enter the Image URL as the name of the image document uploaded into Microsoft SQL Server 
Reporting Services, 

 

Figure 37: Image URL field within Van Line setup 
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Note:  If the Image URL field is not listed, then add it by right-mouse clicking on the Van Line 
folder name, selecting New > Fields, and choosing the ImageURL field from the pop-up windows 
listed.  Press Add to close the window and add the field to the Van Line setup table. 
 

12. Press the TAB key through the remaining record values to keep the change made to the Image 
URL field.  Note: The van line referenced for the imaging is that assigned to the branch.  Refer to 
the MoversSuite Administration - web > Common > Branch Setup > Van Line field, 

13. Repeat Steps 10 through 12 above steps to assign image files to other van line records. 

 

Turning on the branch and van line image functionality 
 
So far in this process, an image file has been loaded into the report server and the branch and van line 
records have been updated to reference the uploaded image file.  The last step is to set flag(s) for each 
report document to include the image.  
 

Turning on branch and van line imaging for a document 

1. Open the Mover’s Suite Administration, 

2. Open the AFS > Invoice > Invoice Properties setup folder, 

3. Select a report document from the list of Report Name values, 

Note: Only certain report documents have been designed to display the branch or van line 
image.  Contact Mover’s Suite to find out more about adding images to other documents. 

4. Place a check in the column to Include Branch Image and/or Include Van Line Image for the 
selected report document, 

 

Figure 38: Include image options within Invoice Properties 

5. Press the TAB key through the record to keep the changes, 

6. Repeat Steps 3 through 5 to enable other report documents to display the branch or van line 
image.   

If the Include Branch Image or Include Van Line Image is on and a branch or van line image has not 

been loaded into the report server, then an image rendering error icon ( ) will appear in its place. 
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Custom Report Document Setup 
 
Custom documents are files considered outside the standard list of documents provided by Mover’s 
Suite, including those documents developed by Mover’s Suite for a specific customer. 
 
In any case, these documents should follow the same rules that apply to standard Mover’s Suite 
documents.   Additionally, they should be stored within a directory that is accessible to the Mover’s 
Suite application, but safe from application’s installation process.   

Custom Letter and Crystal Report Documents 
 
Documents defined as Letters or Crystal Reports, which must physically reside on the application server, 
should be stored in a place where they will not be overwritten by a Mover’s Suite process.  In general, 
the \\[Server Name]\mssShare folder will not be overwritten and is considered a safe place to put 
custom documents, however, the name of any custom file should not be the same as any standard 
Mover’s Suite file; the Mover’s Suite installation process will overwrite any file that is of the same name 
as the file it is attempting to place on the system. 
 

Suggested format for custom physical documents: 

\\[Server Name]\mssShare\mssLetters\Custom\ 

-Or- 

\\[Server Name]\mssShare\mssLetters\Crystal Reports\ 

  Where [Server Name] represents the name of the server that hosts Mover’s Suite 

 

Custom Report Services Report Documents 
 
Custom reports designed within Reporting Services should also be stored within a safe folder within the 
server.  This is typically done by creating a folder that separates these documents from the standard 
ones supplied by Mover’s Suite. 
 
In the example below, a user has created a custom folder from within the Report Manager. 
 

 
Figure 39: Custom folder from within the Report Manager 
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The Report Path that would be referenced for the Reports setup would be similar to the following, for 
example: 

http://[Server Name]/ReportServer/Custom 

Where [Server Name] represents the name of the reporting server 

 
Contact your Mover’s Suite support professional for more information on custom reports. 
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Allowing Access to Reports Documents 
 
To access Reports documents within Mover’s Suite, a user’s Report Profile must be updated.  A Report 
Profile is a type of user that can access the reports.  This type is assigned to a user through the 
Personnel settings. 
 
A Report Profile can have any number of documents assigned to it through the Report Profile Details 
setting.  The Report Profile Detail setup links documents defined in Reports to a Report Profile. 
 

 
Figure 40: Reports setup flow diagram 

 
Once the document is linked to the employee, they will be able to access the document through 
Mover’s Suite. 

Report Profile Settings 
 
Define a group of users to access documents within the Report Profile setup. 
 

Establishing Report Profiles 

1. Access the Mover’s Suite Administration, 

2. Open the Common > Reports > ReportProfile setup, 
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Figure 41: Report Profile Detail setup section 

3. Click the mouse in the row describing “Click here to add a new row”, 

4. Enter a Description for the group of users who will be access the reports, such as “Coordinator”, 

5. Press the Tab key to add the record to the database, 

6. Repeat steps 3 through 5 to define other profiles. 

 

Report Profile Detail Settings 
 
Report Profiles are typically established when MoversSuite is initially installed and will be available 
within a drop-down menu, when updating the Report Profile Details.  Updating these records creates 
the link between the Reports documents and the Report Profile. 
 

Linking Reports to Report Profiles 

1. Access the Mover’s Suite Administration, 

2. Open the Common > Reports > ReportProfileDetail setup, 
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Figure 42: Report Profile Detail setup section 

3. In the entry row, select a Report Profile from the list of available profiles, 

4. Select a Report Name from the list of available report documents, 

5. Press the Tab key to add the record to the database, 

6. Repeat steps 3 through 5 to define other profiles. 

 

In the example below, the profile titled “Coordinator” has access to the documents titled Unassigned 
Order, Unregistered Orders Master, Unregistered Orders, User Details List, and Work Ticket.  

 

 

Figure 43: Report Profile Detail example 

 
View the Reports and Letters Report for a complete listing of profiles and reports. 
 
Changes made here affect which reports will be available to a user, as further defined within the 
Personnel setup of the MoversSuite Administration - web. 
 

Report Profile Setting in Personnel Setup 
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The Report Profile setting, within the Personnel setup of the MoversSuite Administration - web allows 
an administrator to assign Report Profiles to employees, hence giving them access to the documents it 
represents. 
 
Setting or updating a user’s Report Profile, will grant them access to the documents for which the profile 
represents. 
 

Assigning Personnel to a Report Profile 

1. Access the MoversSuite Administration - web, 

2. Select the Personnel setup within the User Setup section, 

3. Choose an Employee from the list available through the drop-down menu, (or press New to 
create an employee record) and the data for the employee will paint to the screen, 

4. Click on the User Setup tab, 

 

Figure 44: User Setup tab of Personnel Setup 

 

5. Press Edit to allow for the fields to be edited, 

6. Select a Report Profile from the drop-down list, 

7. Press Save to keep the change, 

8. Repeat steps 2 through 7 to update the profile for other employees. 

 
Once set, the user can then access the application and view the documents assigned to them. 
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Troubleshooting Reports 
 
This section covers the causes and resolutions to some of the more common reporting problems a user 
may encounter. 
 

Issue: Document is missing from the list of reports 

Cause: The user does not have access to the document, or the document is not defined. 

Resolution: Verify that the document is established within the Reports setup and that user has 
appropriate access to the document.  

Check the following areas: 

Mover’s Suite Administration: 

- Common > Reports Setup  (to ensure that the document is defined) 

MoversSuite Administration - web: 

- User Setup > Personnel > User Setup (to ensure that the user is in the correct 
Report Profile) 

Reference the Reports and Letters Report to identify which reports and profiles have 
been defined to be accessible within MoversSuite. 

 
 

Issue: Document cannot be found 

Cause: The application or the Report Viewer may list an error when it cannot find a file.  The 
error should include the name of the file that it is attempting to open.   

Resolution: Verify the settings within the Reports setup of the Mover’s Suite Administration.  If the 
settings are correct and the file is a Reporting Services Report, then verify that the 
report is correctly loaded within the Report Server.  If the problem persists, contact an 
Information Technologies (IT) expert. 

 
 

Issue: Document button pushed, but nothing happens 

Cause: Often a report may take longer to generate than is anticipated.  When the document is 
generated through a button, no Report Viewer message will display and, often, error 
messages may not appear. 

Another cause could be that the System ID for the button is missing or invalid within the 
Reports setup. 

Resolution: Wait for the report to generate, or check the System ID setting within the Reports setup 
(refer to the Accessing Documents through Buttons section for a complete listing). 
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Issue: No record found 

Cause: The program was unable to locate any records, or an invalid argument was entered as a 
parameter.  The latter typically involves the user selecting a system-generated 
document from the lower section of the Reports menu.  Errors similar to “The … 
parameter is missing a value” or “0 could not be found” will usually be generated from 
this. 

Resolution: Verify that the argument was entered correctly, and for system-generated reports, 
setup the document to be rendered through a button (see the Accessing Documents 
through Buttons section).  

 
 

Issue: Reporting Services Error 

Cause: There can be a number of reasons that can cause a Reporting Services error, including 
that the Reporting Service is not responding, cannot find requested document, the 
requested document is of the wrong type, the application is attempting to pass invalid 
data to the document, etc. 

Resolution: If the error returned is not enough to identify and correct the problem, then verify that 
the requested document is setup correctly and that the Reporting Services is running 
correctly, or contact you Information Technology (IT) expert to identify the source of 
the problem.  

 

 

Issue: Branch or van line image not appearing on customer statements, invoices, or quotes 

Cause: Image not loaded into the report server or is placed in the wrong folder in Report 
Manager.  Another cause may be that the document has not been designed to render 
images. 

Resolution: Verify that all the steps have been followed as documented in the Adding Branch and 
Van Line Images to Documents section.    
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Sample Reports Settings 
 
A sample of the Reports setup for the three Report Types is listed below: 
 

Crystal Report Sample Reports Setup 

Menu Name Government Form 1113 

Report Name Gov SF1113.rpt 

Report Path \\RSQL-01\mssShare\mssReports\Crystal Reports\Forms\Government 

Report Type Crystal Report 

System ID RSBI or REVI 

Render Type Adobe Portable Document Form 

 

Letter Sample Reports Setup 

Menu Name Order Confirmation 

Report Name Order Confirmation.doc 

Report Path \\RSQL-01\mssShare\mssLetters 

Report Type Letter 

System ID  

Render Type Adobe Portable Document Form 

 

Reporting Services Report Sample Reports Setup 

Menu Name Quote 

Report Name /MoversSuite/System/Quote 

Report Path http://RSQL-01\ReportServer 

Report Type Reporting Services Report 

System ID QUOT 

Render Type Adobe Portable Document Form 

 


